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TEAC PROFESSIONAL

Cubase LE 5

Quick Start Guide

This chapter explains basic operations for
using the unit with Cubase LE 5.

This explanation is not intended to replace
the user’s manual for Cubase LE 5. Also,
since Cubase LE 5 is a product provided by
Steinberg Media Technologies GmbH, it is
not supported by TASCAM.

Please use the Cubase LE 5 Help menu (and
access the PDF manuals) for information
about how to use this software.

Installing Cubase LE 5

Trademarks

« TASCAM is a trademark of TEAC
Corporation, registered in the U.S. and
other countries.

o Microsoft, Windows, Windows XP,
Windows Vista, and Windows 7
are either registered trademarks or
trademarks of Microsoft Corporation in
the United States and/or other countries.

« Macintosh, Mac OS and Mac OS X are
trademarks of Apple Inc., registered in
the U.S. and other countries.

« Cubase and VST are registered
trademarks of Steinberg Media
Technologies GmbH. ASIO is a
trademark of Steinberg Media
Technologies GmbH.

« Other company names, product names
and logos in this document are the
trademarks or registered trademarks of
their respective owners.

1 Insert the Cubase LE 5 DVD-ROM
into the DVD-ROM drive on your
computer.

The system displays the language
selection screen (below). Select the
language you prefer.

If this language screen does not
appear automatically, do the
following:

Windows: Run the

Cubase_LE_5_Start_Center.exe on
the DVD-ROM.

Mac: Run the Cubase LE 5 Start
Center program on the DVD-ROM.

WELCOME TO

(- CUBASE LEs
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2 The installation screen appears. 5 The system displays the License
Click Install Cubase LE 5. Agreement for end users. Read the

contents, then select | accept the
Tu=c

license agreement if you agree to the
terms. Click the Next button.

2 License Agreement

war o CUBASE LEs

y - ]

Enduser License Agreement (EULA)

Steinberg
Software End User License Agreement
(EULA) for eLicenser Control

>

The following information represents the
contractual conditions for the use of software,
manufactured by Steinberg Media
Technologies GmbH by you, the final user.

Install Cubase LE  on your computer.

@ steinberg

e ——— ]

3 The following screen appears.
Click the Next button.

By installing the software on your computer,
ou are declaring yourself to be in agreement
with the contractual conditions, 5o please
read the following text carefully

=

¥ | accept the license agreement

< Bask et > Cancel

€ CubaseLE 5

6 A screen appears to confirm that you
want to close the eLicenser installer.
Press the Finish button.

@ steinberg

Welcome TASCAM

Welcome ta the Cubase LE 5 Selup progiam.
This program wil install Cubase LE 5 on your computer.

=) - ™
Click Nex! to proceed with the default installation of Cubase LE 5. == Installation has finished

Abvanced users may also click Customize to configure the installation process.
eLicenser Control has been successfully
installed.

.
s s ) cores

I Show the Release Notes.

I Start ‘eLicenser Contral Center after installation

4 The system displays the eLicenser
Welcome screen. Click the Next
button to start the installation.

2 Welcome
[H “cENSEn Welcome to eLicenser Control Setup Version
Y 6027004

For a flawless installation please follow the.
instructions below:

- Please connect all your available
USE-eLicensers (i any) to the USE ports of
your computer, and proceed to the next
installation step.

‘= - Please quit all running programs

> Click <MNext> ta start the installation,
A Click <Cancel> to end the installation process

e Y
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7 The Cubase LE 5 installer

automatically starts. Click the /nstall
button.

i¥3 Steinberg Cubase LE 5 Setup

- CUBASELE:

| The Setup Wizard is ready to begin the Installation

Click Instal to begin the Installation,

< Back

Cancel

The system displays the License
Agreement for end users. Read the
contents, then select | accept the
terms in the License Agreement if
you agree to the terms. Click the Next
button.

i Steinberg Cubase LE 5 License Agreemnent

- GUBASELE;
| End-User License Agreement
Please read the following icense agreement carefully

[HE3

Steinberg
Software End User License Agreement (EULA)
General

Al intellectual property rights in the software belong to Steinberg
hedia Technologies GmbH (hereinafter: "Steinberg") and its ~

(1 arcept the terms in the License Agresment:

()1 do not accept the terms in the License Agreement

T (A=)

A screen appears where you can
select the location where you want

to install the software. Designate the
location where you want to install the
software and click the Next button.

i# Steinberg Cubase LE 5 Setup X
< CUBASELE: @ stoinberg
| Install Lecation
Click the next Button to Install Steinberg Cubase LES .
Create Shortcut on Desktop
Instal Location:  Ci\Program Files\SteinberglCubase LE 51
<=

10 A screen showing that preparation

for installation is complete appears.
Click the /Install button.

i Steinberg Cubase LE 5 Setup %)

> CUBASELE: =

| Ready to Install

(® steinberg

The Setup Wizard is ready to begin the instalation

Click Install to begin the installation. IF you want to review o change any of your
instalation settings, dick Back. Click Cancel bo ex: the wizard,

)
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11 Installation of Cubase LE 5 starts.

i Steinberg Cubase LE 5 Setup

< CUBASELE: @ stoinserg
[ Installing Steinberg Cubase LE 5
Please wait whis the Setup Wizard installs Steinberg Cubase LE 5, This may take several
mintes,
Status:
i ]
<Back Next >

12 When the installation completes,
press the Finish button to end
installation.

i% Steinberg Cubase LE 5 Setup

- GUBASELE;

(@ steinberg

| Completing the Steinberg Cubase LE 5 Setup Wizard

Click the Finish button ko exit the Steinberg Cubase LE 5 Setup Wizard.

—

13 When the installation completes,
press the Finish button to close the
installer.

€ Cubase LE 5 3]

| Installation completed

Cubase LE 5 has been successhully installed

Press the Finish buttan b exit this installation.

—
G
R
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You can download updates for Cubase LE
5 from the following Steinberg website. We
recommend that you always use the latest
version.

Please abide by all the precautions listed on
the site before updating.

http://www.steinberg.net/en/support/
steinberg_support_downloads.html

Cubase LE 5 can be used for 30 days (or
launched 3000 times) in demo mode until it
becomes disabled. If you want to continue
to use it for a long time please refer to

the Getting Started on the DVD-ROM and
register your program.



Recording with Cubase LE 5

The settings in Cubase LE 5 are the same
in Windows XP, Windows Vista, Windows
7 and Mac OS X.

The screens in the example below are from
using a US-144MKII with Windows XP.

Preparation

1 Launch Cubase LE 5 and select
Device Setup... from the Devices
menu.

“ CubaseLE 5
File Edit Project Audio MIDI Media Transport

MIDI Device Manager

Mixer

Plug-in Information

¥5T Connections

wsT Performance

video Window

Virtual Keyboard Al

Show Panel

2 Click VST Audio System on the left
side of the Device Setup window. Set
the ASIO Driver item on the right to
US-122MKII/US-144MKIl.

* Device Setup 5]
+ " VST Audio System
Devices Ful Dupiex Driver [T
= o B/l weomer "
© MDDl Part Setup
13 Video

Sample Rate: 44100.0Hz

510 Di
VST System Link

Advanced Options _Setto Defauls

sudo Pty

Mk Processing

Bl
s | ) Disk Preboad
Adiust for Record L atency

|21 Record shift

q 5

3 When the following dialog appears,
click the Switch button.

“ Cubase LE5

9
\') Do you want to switch the ASI0 driver?

T~
(UWitch l) Keep I

—

The following screen appears.

* Device Setup (3]

+ " VST Audio System

Devices

[=] 4510 Diver

CT— [ —m—.
v oLy 23000

Sty 7O

Sudehoe ook

VST System Link

Advanced Options  Setto Defaulls

Hormal [-] fuucio Pricrity

MuliProcessing

. e O

4 Click US-122MKII/US-144MKIl on

the left side of the Device Setup
window and confirm that the I/O
ports are set to US-144MKII ports.
Then, click OK to close the window.

T ®
- " US-122 MKIIf US-144 MKIl
EE— oy 350me

= Ouputlgeney 55T

i
]
U5 144 it ou L

i
US 14000 il o 7

M o
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5 Select VST Connections from the
Devices menu.

Confirm that the Device Port is set to
US-144MKII on both the Input and
Output tabs.

Close the dialog after confirming.

mE A 2B Presots NN -1

o Device TDevice Port T

S Stoin Sieeo US122NKI/US- 144 2
o U 184 arakginl.
o i US 184 M0 andsgn

VST Connactions - Outputs
reuts | Outputs |
EE Al Add Bus Precets N -
Tl [Spetes (Ao [Gereeran Ta ]
= S0 sl US048 ok =
oy S e s
B US4 e

TIP

To use the digital input and output of the
US-144MKII as inputs and outputs for
Cubase LE 5, add the digital input and
output on the Input and Output tabs of the
VST Connections window.
« Click the Add Bus button.
«  When the following dialog appears,

set the Configuration to STEREO and

the Count to 7 and then click the OK
button.

6 TASCAM Cubase LE 5

The windows should appear as follows
and the digital input and output should
be available for use.

Device Port T
US122 K1/ US 164k =

US144 WKl gL

US 144 MKl bR
S22 K1 /US4 K

US 144 M gt n .
US 144 MKl gt .

"
US4 K g oL
US4 M) g ot A

US22MK 7 US 144

US 100 il ou

US 1401 gt ou

Select New Project from the File
menu.

“ New Project 3]

Templates:

CLE - 16 MIDI Tracks.

CLE -4 Sterea & Mono Auio Track Recorder
CLE - Cubase Synihs On Instiument Tracks
CLE - Mastering Setup.

CLE -Padeasting

default

A window appears that allows you to
select a template for the new project.

Choose the template that you want
and click the OK button.



7 Next, the Set Project Folder window
appears. Select the folder where you
want to save the project and click the
OK button to complete creation of a
new project.

Set Project Folder |E|E|

Set Project Folder

Deskkop
@ My Documents
4 My Computer

[ Make New Folder ] ook [ Cancel

If you choose the “Empty” template, use the
“Add Track” item from the “Project” menu to
add audio tracks.

“ Cubase LE5

File Edit (8 Audio MIDI Media Transport Devices wWindow Help

I - R

I Instrument

= Ml
Show All Used Automation

Hide All Automation J FX Channel
Pl Ctrl+p | [ Folder
Markers Chrl+M P Group Channel
Tempa Track Cel+T *7 Marker
Project Setup... Shift+5 T video

Auto Fades Settings...

“ Add Audio Track

Audio Track Configuration

1 Mono M

When recording a vocal or an acoustic
guitar, for example, with a single
microphone, create and record to a mono
track.

When recording a piano in stereo with two
microphones or recording a keyboard or
similar device using the stereo line input,
create and record to a stereo track.

TASCAM Cubase LE5 7



Recording

1 Select the track that you want to

record to, and set the input bus in the
Input Routing field on the left side of
the window.

Fle Edit Project Audic MIDI Media Transport Devices Window

“ Cubase LE 5 Project - Untitled1

I

[m | s Audic 01
mro @ ®

> | LD B3 Audio 02

_IZI oo o (n} mm
> - IDE Audio 03

0.00 (o) R | w]

L n > | IDE Audio 0

No Bus OO0 M
. StereoInz F Right

Press the Monitor button if you want
to hear the input signal.

=1 [m] s Audia 01
mor @Elm

8 TASCAM Cubase LE 5

After you have completed setting the
input buses for every track, click the
Record Enable buttons (making them
red) for the tracks that you want to
record on.

File Edit Project Audio MIDI Media Transport Devices SWindow
" Cubase LE 5 Project - Untitled1
0B CEED IR

e

[ m | || Audbo 01
mere | @0 (R

EDEE| Audio 02
<R[ w|

LR Audio 03
<R[ w|

LN Audio 04
R w]

Press the (REC) button in the
transport section to start recording.

‘When you finish recording, press
the (STOP) button, then click the
Record Enable buttons to turn it off
(the button indicator will turn off).
Rewind if necessary.

Repeat steps 1-4 to overdub
additional tracks.



Mixdown 3 In the Export Audio Mixdown dialog
box, make the desired settings, then

1 Move the left and right locators to press the Export button.

specify the region that you want to
mix down.

W iy

On this screen, set the File Name,
Path (location where saved), File
Format, Sample Rate, Bit Depth
and other attributes of the file to be

2  From the File menu, choose Export > created.
Audio Mixdown. 4. The following screen appears while
* Cubase LE 5 the file is being created.
FEM Edit Project aAudio MIDI Media Transport Devices ‘Window + -
Export Audio Mixdown
Mew Praject... ChrHN TS
open cubo I T
Close Chrl+i
Save Chrl+s
Save As... ChrHshift+5

Back up Project...
Save as Template...

After the file has been created, press
the Close button on the Export Audio
Mixdown window to close it. The

Impart 3
mixdown file is saved according to the

Preferences. ..
key Commands. ..

settings made in step 3.

Quit Chrig
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Troubleshooting

This chapter answers frequently asked
questions related to recording with Cubase
LES.

Q1.

A1l.

Q2.

A2,

I think I have configured the
input settings properly, but | see
no activity on the audio track's
meter.

Make sure that the Monitor button of
the track is enabled.

1 [m ]S ] Ayging

mono @ R

I would like to record two
channels simultaneously in
stereo.

Before you record, choose Stereo
track(s) or add Audio track(s) as
Stereo.

If the project does not have a stereo
track, select Project menu > Add
track > Audio and create the number
of stereo tracks that you need.

* Add Audio Track

10 TASCAM Cubase LE 5

Q3.

A3.

As shown below, you can confirm that
a track is stereo by the word “stereo”
in the channel display and by the input
display, which should say “Stereo

In” or something similar, when the
channel is selected.

Audio 01 le]

—— = =1l 1LLnLS | Audio 01
. EDLE

I am trying to use the EQ, but it
does not seem to do anything.

Confirm that one or more EQ switches
are on in the EQ section for the
channel in the Inspector.

EQ OFF

EQ ON



Qa.

A4,

| tried to mix down a three-
minute song, but could mix only
ten seconds.

Make sure that the region specified
by the left and right locators is set to
three minutes or longer.

Q5. | cannot set the locator region to

more than ten minutes.

ADb5. The default setting is ten minutes.

From the Project menu, choose
Project Setup and then change the
Length field.

“ Cubase LE 5

File Edt BIWEES Audio MIDI Media Transport Devices  Window
Add Track
Duplicate Tracks
Remove Selected Tracks

Show All Used Automation
Hide All Automation

Pal Ctr+p
Markers
Tempa Track

Ctrk+m
Chrl+T
Pro| Do,

Auto Fades Settings. .

EZRLETOE -| 5amle Rate
Record Famat

T - | Stereo Pan Law

Hep  |[ ok ][ cancel

Q6.

AG6.

Q7.

A7.

I burned a CD using the WAV file
I mixed down, but the speed is
obviously different.

Could the sampling rate of your
project be set to 48 kHz? If your
ultimate objective is to create a CD,
TASCAM recommends that the
sampling rate be set to 44.1 kHz from
the beginning.

To specify the sampling rate, choose
Project Settings from the Project
menu, then set the sampling rate to
44.100 kHz.

“ Project Setup 53

[ -] Frame Rate |

[l -] Display Format

TR Disoay Oifset

[ -] Record File Type

Sl -| Stereo PanLan

Hep [ ok | cancal

I have connected an audio source
to the Unit, but cannot hear
anything.

Make sure that the input level of the
audio interface is raised appropriately.
When a signal is being input, the
signal indicator of the audio interface
will light up green. Make sure that the
monitor (or headphone) level is raised,
and that the connections are correct.

TASCAM Cubase LE5 11



Q8. The sound is distorted.

A8. Make sure that the signal is not
overloading. If the signal is analog,
the ideal level is when the overload
indicator lights up red occasionally.
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